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1 – Introduction

The 1.3 branch is the first branch to introduce the Stage tool in EigenD. It's now considered 
stable.  This means that we'll be bug fixing only from this point.

1.1 – Stage

Stage is a graphical user interface for accessing parameters in EigenD setups. Stage allows 
users to create customized layouts of on-screen controls, such as sliders and knobs, to 
manipulate the setup parameters that they would like to control.

To open stage, click Tools->Stage in the main EigenD menu.

For more details and instructions on using Stage, see the Stage Documentation Wiki: 
http://www.eigenlabs.com/wiki/Stage/

1.2 – New routing matrix

As of release 1.3.7,  the controller routing matrix for the AU/VSTs is now also capable of 
configuring which MIDI messages should be sent. This MIDI routing functionality is also 
available for the MIDI output instruments and will appear as 'Midi Converter' in the 
'Window' menu of EigenD.

The capabilities of the new routing matrix are much more versatile than before. For details 
and instructions on how to use the new routing matrix, see the corresponding documentation 
in the wiki:
http://www.eigenlabs.com/wiki/Routing_Matrix/

2 – Bugs fixed in this release

The 1.3 branch contains all bug fixes from Release 1.2.14 onwards.

• Release 1.3.32-stable
◦ Stability improvements to the AU/VST host agent.
◦ AU/VST plugins could crash when the audio agent changed the audio device or 

sample rate while loading the plugin state. All plugin state is now loaded during 
the last stage of setup loading.

◦ The scale manager agent could sometimes not load its state.
◦ Creation of some logfiles could cause EigenD to crash when permissions didn't 

allow it or another error occurred during the logfile creation.
◦ The Stage OSC and XML/RPC servers could get stuck in shutdown when setups 

were loaded successively.

• Release 1.3.31-stable
◦ Keyboards lights could sometimes not appear when replugging the instrument or 

waking from sleep.
◦ Tau keyboard lights were sometimes wrong when not on the main keyboard.
◦ Activating keygroup outputs through Belcanto didn't currently switch to the 

associated lights.

http://www.eigenlabs.com/wiki/Routing_Matrix/
http://www.eigenlabs.com/wiki/Stage/


• Release 1.3.30-stable
◦ Some AU plugins were showing the generic interface instead of the custom GUI, 

this is now fixed.
◦ Some AU plugins caused the EigenD  interface to become unresponsive when 

hiding their GUIs, this is now behaving correctly.

• Release 1.3.29-stable
◦ Factory setups now load without warning message on older versions of Alchemy.
◦ Tau Cello and Clarinet Monophonic toggle buttons were reversed.
◦ Alpha factory 2 & 3 Cello and Clarinet Monophonic keyboard toggles are now 

working.
◦ Tau AU/VST Stage tabs now use the correct scalers.
◦ Pitch bend curve setting 4 now behaves correctly for AU/VST instruments.
◦ Alpha factory 3 Stage scale selection tabs are now correct.

• Release 1.3.28-testing
◦ Talker kgroup blink is now disabled so that the main kgroups can blink faster than 

the talker kgroups. This was experienced as the blink time not being able to go 
below 0.5ms.

◦ Stage tab fixes to Alpha factory 2 for scale browsing.
◦ Alpha factory 3 now updates all tonic and scale lights correctly when MIDI input 

notes are used to change tonics and scales.
◦ The kgroup blink port can now be un set, which is the same as setting it to 0.

• Release 1.3.27-testing
◦ Fix to arranger not playing first event.
◦ Fix to remember default setup across EigenD upgrades.
◦ Fixes to EigenD wake from sleep.
◦ Fixes to incremental setup loading.
◦ Fixes to Tau percussion keys to MIDI connection in factory setup.
◦ Updated integrated routing matrix document documentation.
◦ Changed Audio Unit and MIDI converter program change and bank change 

bounds to be 0-127 instead of 1-128 for consistency.
◦ EigenD doesn't need to be restarted anymore when custom scales are added.
◦ Fixes to remember warning dialog ignores across EigenD restarts.
◦ Fix to make VST plugins with generic GUIs work.
◦ Fixes to make AU plugins with generic GUIs work in setups that aren't using an 

Apple AU already. 
◦ Pop up warning dialog when certain functionalities aren't available due to 

insufficient bandwidth on the USB bus on MacOSX.
◦ Updated Pico and Alpha references guides based on the most recent factory 

setups, the Tau version will follow soon.
◦ Fix to only upgrade old setups when no setups are present for the running version 

(could be experienced as being unable to delete setups).
◦ Fixes to Stage connection code and addressing.
◦ Fixes to Alpha/Tau keyboard replugging.
◦ Unusable ports are now hidden in Stage.
◦ Missing agent and port tooltips have been written for Stage.



• Release 1.3.26-testing
◦ Fix to MIDI control parameter mapping for non-key parameters
◦ Fix to make MIDI program change and band change work correctly from talkers.
◦ Fix to MIDI poly-pressure when mappings are not per-note.
◦ Fix to plugin cache for rare occasions where it might be empty.
◦ Improvements to the OSC and internal networking to.  Packet loss was causing 

some belcanto operations to run slowly, and also causing Stage to lose the initial 
values of some widgets.

◦ Fix to recorders not stopping when metronome is stopped before the end of a 
recording.

◦ Fix to recorded takes sometimes jumping between scales, tonics and octaves.
◦ Fix to recorder arming to that it always works, even when the clock is not 

running.

• Release 1.3.22-testing
◦ Streamline Windows USB Driver
◦ General bugfixes, and fix for odd behaviour with varying buffer size.
◦ Sort out Windows process priorities.

Thanks to Ferdinand Strixner for pointing out bugs and helping us recreate
problems.

Please note that there is also an updated Windows device driver available:

http://www.eigenlabs.com/downloads/releases/state/resources

Also, please make sure that your Windows system is fully updated to Windows
SP1; There are some important USB related bug fixes.

• Release 1.3.20-testing
◦ Fix for alpha initialisation talking a long time in setups with no Audio agent.
◦ Fix for changes to kgroup scale and octave not always persisting.
◦ Added an xmlrpc to query values of ports.

• Release 1.3.19-testing
◦ Fixed the latching of damper signals in recording causing recorded notes to be 

sustained (possibly indefinitely) when a take stops.
◦ Fix a problem setting the process priorities of helper programs.

• Release 1.3.18-testing
◦ Fixed a threading problem with talker activation.
◦ Fixed a threading problem with the Pico.
◦ Fixed a page fault during recorder playback.
◦ Added overdub toggle talkers for each instrument on the Alpha keyboard.
◦ Updated Stage Alpha factory setup tabs to include the overdub talkers and pre-

fader headphone sends.
◦ Added kgroup and scaler tabs for each split to Alpha factory setup 3.
◦ Fixes to AU bypass light indicator after setup loading which was always 

http://www.eigenlabs.com/downloads/releases/state/resources


defaulting to on.
◦ Fixes to AU/VST plugins with more than 32 output channels.

• Release 1.3.17-testing
◦ Talker buttons in Stage now show proper status.
◦ Issues with 14bit MIDI CC's corrected

• Release 1.3.16-testing
◦ ASIO compatibility improvements.

• Release 1.3.14-testing
◦ Fixes to Belcanto interpreter.
◦ Better error handling for early startup problems.

• Release 1.3.13-unstable
◦ Fix to polyphonic aftertouch not sending out data at times when multiple keys are 

pressed.
◦ Fixes to rate decimation where only the first key would send out fine-grained 

data.
◦ Fixes to AU, VST and Midi Converter settings loading with regards to properly 

restoring rate decimation, note on/off and pitchbend states.
◦ Fixes to automation parameters for AUs that expose them late. This fixes 

parameters not displaying for some Arturia plugins.
◦ Fixes to controllers; values can be controlled by both Stage and the keyboard 

again.
◦ Scripts now support comments.

• Release 1.3.11-unstable:
◦ Fix to legato trigger in case less than 16 MIDI channels are in use.
◦ Fix to relative strip signals to allow the last zero value to come through.
◦ Make Alpha/Tau headphones more resilient with respect to different sample rates 

and block sizes.

• Release 1.3.9-unstable:
◦ Stage widget steps set to appropriate default values in factory setups.
◦ Fix to tabs not updating correctly when switching setups.
◦ Fix to widgets being duplicated when exporting and importing tabs.
◦ Fix to small steps on rotary knobs not working for large ranges (e.g. metronome 

tempo with a rotary knob with a step of 1).
◦ Fix to Stage crash on exit in fullscreen mode.
◦ Minor Stage UI fixes.
◦ Fixes to setup upgrades from previous stable and testing releases.
◦ Routing matrix UI stability fixes.
◦ Routing matrix mapping improvements by making all bounds individually 

settable through the UI.
◦ Fixes to MIDI packet timestamps for physical and virtual outputs. This should 

improve compatibility with Ableton Live.



• Release 1.3.7-unstable:
◦ Fix to EigenD not starting if more than one network interface is in use, e.g. 

wireless and a VPN connection.
◦ Fixed bugs in agent tree and widget updating when agent and atom names are 

changed using Belcanto.

• Release 1.3.6-unstable:
◦ Fixes to crashes whilst changing setups for both Stage and EigenD.

• Release 1.3.3-unstable:
◦ Fix crash in Stage when dragging an agent onto the canvas with no sub-tree.

3 – Bugs and known issues in this release

• Alpha and Tau are not supported under Windows, work is ongoing in the 1.4 branch.
• Windows Vista is not supported.
• Some non looping AIF's will still not play.

4 – Changes and Improvements

• Release 1.3.29-stable
◦ All AU/VST stage tabs now have 'Key Pitch Bend Range' knobs.
◦ The default octave of the instruments in the Tau factory setup has been lowered.
◦ The Tau factory setup now has scroll keys on the first five percussion keys. They 

can be activated by selecting the 12th key while pressing the percussion keys 
mode key. Note that it's not possible to upgrade older setups automatically to add 
these scroll keys since the EigenBrowser and EigenCommander both have to be 
open. This can however be done manually by executing the following Belcanto as 
a script or commands in the EigenCommander:

empty join
percussion kgroup hey output 12 create

percussion kgroup output 12 k 1 yaw output to eigenbrowser sideways 
nudger 1 connect
percussion kgroup output 12 k 1 roll output to eigenbrowser vertical 
nudger 1 connect
percussion kgroup output 12 k 1 activation output to eigenbrowser 
tapper 1 connect

percussion kgroup output 12 k 2 yaw output to eigenbrowser sideways 
nudger 2 connect
percussion kgroup output 12 k 2 roll output to eigenbrowser vertical 
nudger 2 connect
percussion kgroup output 12 k 2 activation output to eigenbrowser 
tapper 2 connect

percussion kgroup output 12 k 3 yaw output to eigenbrowser sideways 
nudger 3 connect
percussion kgroup output 12 k 3 roll output to eigenbrowser vertical 
nudger 3 connect
percussion kgroup output 12 k 3 activation output to eigenbrowser 
tapper 3 connect

percussion kgroup output 12 k 4 yaw output to eigencommander 



sideways nudger 1 connect
percussion kgroup output 12 k 4 roll output to eigencommander 
vertical nudger 1 connect
percussion kgroup output 12 k 4 activation output to eigencommander 
tapper 1 connect

percussion kgroup output 12 k 5 yaw output to eigencommander 
sideways nudger 2 connect
percussion kgroup output 12 k 5 roll output to eigencommander 
vertical nudger 2 connect
percussion kgroup output 12 k 5 activation output to eigencommander 
tapper 2 connect

• Release 1.3.28-testing
◦ Alpha factory setups now have overdub keys in the advanced MIDI sections.
◦ The Tau quick reference guide is now fully up-to-date with the factory setup.
◦ The Tau factory setup now has pedal 1 connected to sampler 1 piano sustain.
◦ The Tau factory setup now has all the recent features of the Alpha setups, 

including:
▪ MIDI input support
▪ MIDI input control on the keyboard
▪ MIDI clock control on the keyboard
▪ MIDI input scale, tonic, setup and metronome triggers through MIDI notes
▪ Pedal calibration
▪ Script browsing
▪ Per-instrument overdub toggle
▪ Belcanto playing from the instrument

◦ The Tau stage tabs are all updated to reflect the new setup features.
◦ The Tau and Alpha setups now have a pedal calibration Stage tab.
◦ The Pico setups now have a global overdub toggle on the main Stage tab.

• Release 1.3.27-testing
◦ Due to a prior bug in Stage, certain existing widgets might be disconnected and 

shown as greyed out or having a surrounding red rectangle. To reconnect these 
widgets, follow these instructions:
▪ Unlock the Stage editing by clicking on the padlock icon at the top left corner 

of the window
▪ Select the Edit tool which is the third tool in line
▪ Left-click on the widget that has to be reconnected
▪ Uncheck the 'enabled' flag in the widget properties dialog
▪ Confirm by pressing OK
▪ Select the Create tool which is the second tool in line
▪ Wait for the agent list to load
▪ Find the agent and port that the widget is supposed to be connected to
▪ Drag and drop the port from the available agent list onto the widget
▪ The widget will now be reconnected

• Release 1.3.26-testing
◦ Belcanto now supports sending program change messages to AU hosts and MIDI 

convertors, for instance:



audio unit 1 hey midi program to 3 set
audio unit 1 hey midi bank to 6 set
 

• Release 1.3.16-testing
◦ New tabs for all setups.
◦ You can now select which Stage canvas types are to be displayed on a particular 

device.  This is useful to choose which of the various sizes you want to see.

• Release 1.3.14-testing
◦ Stage now includes tabs for the Factory Alpha Setups.

• Release 1.3.10-unstable
◦ Stage now includes a progress status dialog to show the progress when it is busy 

receiving agents or tabs from eigenD.
◦ Stage will only now receive agents from eigenD in the create or help tool modes. 

This improves the start up time to use a setup in perform mode.
◦ The console mixer has a 'prefader' option for effect sends which allows sends to 

be routed before the channel volume when set. By default, the previous send 
functionality of routing the sends after the channel volume is used.

◦ Routing matrix improvements:
▪ instead of allowing a negative scale, an invert button has been added
▪ added per-mapping data rate decimation
▪ added minimum global data rate decimation
▪ kept MIDI CC routings in a dedicated panel, while extracting the other MIDI 

routings to a MIDI Behaviours panel
▪ added per-routing fixed MIDI channel support
▪ added 'always return to base' support for individual routings
▪ added clear matrix button for each individual tab
▪ added toolbar buttons for global settings and clearing all the mappings
▪ added settings for enabling/disabling MIDI notes and pitch bend
▪ added settings for configuring the MIDI channels through the GUI
▪ improved help text and added it for the MIDI converters

• Release 1.3.8-unstable
◦ The steps in which Stage slider, rotary knob or +/- widget values change by can 

be set in the widget properties dialogue.
◦ Bug fixes and improvements to the new routing matrix.
◦ Additional of 'legato mode' for selecting the same MIDI channel when an 

Eigenharp controller is active. This allows notes to temporarily be sent to the 
same MIDI channel even if polyphonic channel cycling is activated.

• Release 1.3.7-unstable
◦ Stage tabs can be moved by selecting the Move Left and Move Right options in 

the tab menu which is opened by right clicking on the widget canvas.

• Release 1.3.6-unstable
◦ Stage widgets can be user enabled and disabled in the widget properties dialogue. 



As for the widgets of removed agents, any user disabled widgets can be 
connected to a new agent port by dropping an agent port in the current setup on 
them from the agent tree.

◦ Adjustable Pan curves in the mixer.  There are some scripts available which set 
various pan curves.

• Release 1.3.5-unstable
◦ Tab imports support importing across setups. Any widgets that connect to agents 

with the same name in the setup they were exported from and the setup they are 
being imported to, will be connected. If the setup they are being imported to does 
not contain agents the widgets were connected to, then they will be disabled.

◦ Widgets are shown are disabled by being 'greyed out'. Any disabled widgets can 
be connected to a new agent port by dropping an agent port in the current setup 
on them from the agent tree. In addition to widgets becoming disabled through 
importing tabs, a widget will become disabled if an agent is removed from the 
current setup.

◦ The horizontal and vertical slider widgets now draw the track from a '0' position 
to represent pan types of controls correctly.

◦ You can now change the quality of the resampling used for the Microphone and 
Headphone interfaces on the Alpha and Tau.  This can have a quite large effect on 
CPU usage.

keyboard 1 hey microphone quality to N set
keyboard 1 hey headphone quality to N set

Where N is from 0 (lowest) to 4 (highest)  

The default is 0 for the headphones, and 2 for the microphone.

• Release 1.3.4-unstable:
◦ A single tab can be exported with the tab name as the default file name.

The tab file import will show an error dialog if the tab file can not be read.
The extension for tabs files is now '.els'.

◦ Talkers now expose a port which enables the talker to be triggered from Stage.
When you browse a talker agent, you'll see a list of keys, and under each key 
you'll see an 'activate' port.  Drag this onto the canvas.  Each key contains a 
number of actions; these are the actions performed by that key.  The tool tip for 
each action will give some clues as to the purpose of the talker.

• Release 1.3.3-unstable:
◦ Create tool now stays active when a widget is created rather than switching to the 

resize tool. Now the agent tree selection is cancelled after creating a widget.
◦ Tabs can be imported and exported from the 'File' menu to an XML file. 

Importing tabs will append the tabs to the current setup tabs.
◦ The rotary widget now draws the circular track from a '0' position to represent pan 

types of controls correctly.

• Release 1.3.2-unstable:
◦ Includes first version of Stage tool in EigenD. 
◦ To open Stage, click Tools->Stage in the main EigenD menu.
◦ For instructions on using Stage, see the Stage Documentation Wiki:

http://www.eigenlabs.com/wiki/Stage/


